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Letters Letters Letters 
In 5D™ Embroidery Extra 
By Janie Lantz, Software Education Specialist 

 

Software Modules Used: 5D™ Embroidery Extra Software 

 

 

Lettering is one of the most frequently used tools in our 
5D™ Embroidery System!  With so many options available 
through the Letter tab in 5D™ Embroidery, plus additional 
fonts available through the 5D™ Purchase Center 
(www.5DPurchaseCenter.com), our designing capabilities 
are endless.  Let’s explore some creative techniques using 
lettering! 

 

Reset All Modules 

1. Open 5D™ Embroidery .  

2. QuickLink to 5D™ Configure . 

3. Click on Reset All Modules.  

4. Click OK to the message, ‘All modules will be closed and reset to their default 
settings’. 

5. When you see the message, ‘Please confirm that all modules except 5D™ 
Configure are now closed’, ensure no other modules are open in the background.  
If they are, click on the module(s) in the background, and close after saving any work 
that might be in progress.  Click OK to the ‘All modules will be closed’ message 
when you have verified all other modules are closed. 

6. Click OK to the message, ‘All modules are now reset to their default settings’.   

Resetting the Modules will make all menus appear as they first installed, reset all browse 
windows to their default size and folder, and make the Control panels and toolbars reset 

http://www.5dpurchasecenter.com/�
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to default.  No changes will be made in custom settings such as MyThreads, 
MyMachines, or MyHoops. 

7. Click OK to close 5D™ Configure.  

 
Open 5D™ Embroidery 

8. Open the Desktop icon .  From the Program Folder, open 5D™ Embroidery . 

9. Click Hoop .  In Hoop Group, select PFAFF® creative sensation™.  In Hoop Size, 
select the 360mm x 200mm – creative™ Deluxe Hoop.  Set Orientation to Vertical. 

10. Click OK to Hoop Selection. 

 
Lettering Characteristics 

11. Select the Letter tab in the Control Panel. 

• Most embroiderers create lettering in a straight line or a circle.  
However, we have many additional line types, called 
Envelope Shapes.  They include Horizontal Line , Vertical 
Line , Circle Clockwise , Circle Counter-clockwise , 
Full Circle , Double Arch , Diamond , Bridge Convex 
Down , Bridge Concave Down , Bridge Convex Up , Bridge Concave Up , 
Arch Over , Arch Under , Fit to Shape , Pennant Right , Pennant Left , 
Fish , Perspective , Italic , Fit to Straight Line , and Fit to Wavy Line . 

• Lettering also comes with over 120 different fonts in Version 9.4, plus Revue 
Patchwork UCM 40-120mm XH to download free from www.5DPurchaseCenter.com.  
Additional font sets are available for purchase through the 5D™ Purchase Center as 
well. 

• Letters now come in different Stitch Types as well.  Let’s look at the Fun Category to 
see the different designators! 

Fonts that have specialty fill types which may be adjusted or changed are called Super 
Fonts, and are signified by abbreviations as follows: 

CS – Continuous Satin 

CF – Contour Fill 

RF – Radial Fill 

http://www.5dpurchasecenter.com/�
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QS – QuiltStipple Fill 

SH – Shape Fill 

SP – Spiral Fill 

ML – Motif Line 

MW – MultiWave Fill 

MF – Motif Fill  

XH – Crosshatch Fill 

Each Super Font has specific options for specialty fills, depending on how the font was 
created.  Not all Super Fonts may be changed to all specialty fill types. 

• Other font designators found in the font name include: 

UC – Uppercase letters with numbers and punctuation 

LC – Lowercase letters with numbers and punctuation 

UCM – Uppercase Monograms, no numbers or punctuation 

B – Uppercase and lowercase English only with numbers and punctuation 

UCB – Uppercase English only with numbers and punctuation 

LCB – Lowercase English only with numbers and punctuation 

UCMB – Uppercase monograms, English only, no numbers or punctuation 

• One more useful thing to know about Fonts:  Not all fonts are created equally.  
Extended, or Full, sets have additional characters for other languages.  Basic sets 
(B) Have only letters, numbers and basic punctuation, depending on their 
designation as we just saw.  Monogram sets have only uppercase letters, plus 
additional characters as designated when they were designed. 

12. Now, you have an overview of Letters and their possibilities.  Let’s create lettering 
embroideries using some out-of-the box combinations! 

 

Choosing Line Types in Lettering 

13. In the Letter tab in the Control Panel, click View 
Font  in the Font menu. 
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14. In the Font Viewer window, the default Category (if you have Reset All Modules in 
5D™ Configure) is Decorative. 

15. The first visible font is Bremen UC 10-24mm.  If you have purchased some additional 
fonts, you may also see Animal Magic 45-120mm, and Art Nouveau 12-20mm CS.  
(Remember, CS stands for Continuous Satin, indicating a Super Font with capability 
of one of twelve pattern fills, satin stitch only, and ability to adjust Density, Stitch 
Compensation, and also the style and amount of underlay.) 

16. Additional fonts appear in alphabetical order, and you can view them by dragging the 
scrollbar at right, or clicking a font in the list and using the computer keyboard arrow 
keys.   
When viewing the fonts using the keyboard arrows, the font name will change with 
each selected font in the Font box at the bottom of the Font Viewer window. 

17. You can also view different Categories (sets or collections of fonts) by browsing Up 
 or Down  in the Category box at the bottom of the Font Viewer.  This feature 

was added in the 9.3 update version (and all later version updates) of the 5D™ 
Embroidery Software. 

18. Browse to the Modern Category. 

19. Click any font in the View list. 

20. Click the up or down keyboard arrows until Gaudy 12-30mm CS is selected, and 
the name appears in the Font box at the bottom of Font View.   
Remember that CS stands for Continuous Satin stitches. 
If Gaudy isn’t in your list, you may not have the most current update for your 5D™ 
Embroidery Software! 

21. Click OK to close Font View and select Gaudy 12-30mm CS. 

 
Set Letter Options 

22. Select 12mm in Font Size. 

23. Click Options in the Control Panel.   

24. In Letter Options, you can change Height or Width 
by percentage.  By changing Height percentage, 
you can make letters taller or shorter at the 
standard width at the chosen size.  Change Width 
percentage to make letters wider or narrower 
without changing the standard height.  Leave 
Height and Width at 100%, which is default Height 



 

 

Page 5 of 11 

©2012 KSIN Luxembourg ll, S.ar.I. CREATIVE, CREATIVE SENSATION, 5D and PFAFF are exclusive trademarks of KSIN 
Luxembourg ll, S.ar.I.  All rights reserved. 

and Width for the selected Size. 

25. Gap increases or decreases how far apart the letters will be.  Some lettering needs a 
larger or smaller Gap to make the letters more readable or more personable.  Gap 
can be set to a negative number, so letters overlap each other for a specialty 
technique!  Set Gap at 0. 

26. Connection allows for jump stitches by default, but also for running stitches so you 
don’t have to trim on small, close-set lettering.  Select the Jump Stitch. 

27. Alignment allows you to choose whether multiple lines of lettering line up on left, right 
or center of the lines.  Choose Left Align . 

28. Spacing increases or decreases the distance between multiple lines of text.  
Depending on the font, you might want to increase the Spacing setting to keep letters 
like ‘y’ from dropping into the line below.  Set Spacing at 1.2. 

29. Stitch Type allows you to choose from a pop-up menu of stitch types you can select 
for change.  These are specific to each font, offering only the types of stitches used 
when the font was designed.   

30. Click the drop-down tab on Stitch Type.  For Gaudy, only one stitch type option is 
available, Continuous Satin.  Click to close the drop-down menu. 

31. Click the ellipsis  beside Stitch Type, and the Continuous Column options 
dialogue box will open. 

32. There are 12 stitch patterns that may be used to texturize and break up long satin 
stitches.  Leave Stitch Pattern at 0 so the letters will be satin stitches.  

33. Change Density to 3.  Leave Compensation at 0 (Compensation adds width or height 
to adjust for the push and pull of stitches as they go into the fabric).   

34. Select Edge Walk underlay, for a running stitch that will tack the fabric to the 
stabilizer, and provide additional support for your embroidery.  Underlay is a personal 
choice, and you can experiment in using Edgewalk, Zigzag, or both to see which you 
like best. 

35. Click OK to Continuous Column. 

36. Click OK to Letter Options. 
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Type in the Words and Make the Lettering 

37. Click in the Letters Box.  Type in:  “A Stitch in Time” then hold down the CTRL 
keyboard key, and then touch and release the Enter key to make a second line for 
text.   
You can add multiple lines of text, and they will all be aligned perfectly! 

38. Type in “saves nine!” 

39. Click Horizontal Line  in Line Type. 

40. Click Apply. 

41. Two lines of lettering will appear in the work area, 
surrounded by a select box with four control handles. 

42. The lines are left justified, and would look better center 
justified. 

 
Edit Properties in Existing Lettering 

43. Place the cursor inside the text select box in the work 
area.  The cursor will change to four arrows, and you can 
right click to open a menu. 

44. This menu has two choices, Properties and Continuous 
Satin. 

45. Select the Properties menu. 

The Properties menu allows you to make changes to the typed 
text, and also adjust Size, Gap, Height or Width proportion, 
Connection, Alignment, and Line Spacing. 

46. In Letter Properties, change Size to 14mm.  Change 
Alignment to Center.  Click OK to close Letter Properties. 

47. Place the cursor in the text select box again, and right 
click. 

48. Select Continuous Satin from the menu. 

49. Click on Pattern 10 (bottom row, second pattern) to create 
a texture with bands of satin stitch.   
A pattern will help prevent snagging that might occur with 
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long satin stitches. 

50. Change Density to 3 for better stitch coverage. 

51. Leave Compensation at 0. 

52. Place a check by Edge Walk for Underlay, to place stabilizing stitches around the 
perimeter of the letters to strengthen and support them. 

53. Click OK to Continuous Satin to see the new texture and other changes. 

54. Click and drag the letters to the top of the hoop. 

 
Create Arched Lettering 

55. Click Double Arch  in the Line Types.   

56. Click the Options button in the control panel.  Click Center in the Alignment box.   
Click OK. 

57. Click Apply in the Control Panel.  

58. The new set of letters will appear in the work area 
surrounded by a select box with six control handles, and 
shaped like a double arch. 

59. Zoom in to about 60 or 70%, using the integrated Zoom toolbar .  Click 
Overview in the Control Panel.  Drag the Overview box until you can see the 
lettering in the zoomed view. 

60. Because we changed the Alignment in Options, all letters we make from this point 
will be Center Aligned , unless we change the default Options again, or close 
5D™ Embroidery. 

61. Adjust the shaping of the letters by clicking and dragging individual control handles.  
When you select a set of letters and adjust with the control handles, the letter size 
will adjust automatically to fit the select box. 
When you adjust letter size through the pop-up Properties menu, the size number 
will not change in the Control panel as the default size for new sets of lettering. 

62. Click Zoom to Fit  to see the whole hoop. 

63. Click and drag the Double Arch lettering toward the top of the hoop, under the first 
set of letters. 
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Create Fit to Shape Letters 

64. In Line Type, select Fit to Shape .   

65. Click Apply to create the set of letters. 

66. This Envelope shape has twelve control handles.  
Click and drag the handles to adjust the letter 
shaping.  Zoom in  as needed to 
facilitate adjusting the control handles. 
Notice you can adjust either of the control handles at the end corners to make the 
letters taller or shorter, and wider or narrower.  However, the control points that sit 
between the corner points can only be adjusted higher or lower in relation to the 
baseline. 

67. Adjust the letters to your liking.  Click and drag them up 
beneath the last lettering you created. 

 
Fit to Straight Line Allows Stepping Letter Angle to Baseline 

68. In Line Type, select Fit to Straight Line .  Place a check in the box by Step, 
which will allow us to adjust the angle of the letters in relation to the baseline. 

69. Click Apply in the Control Panel to create the letters.  They will come in on a single 
line, with square control handles for adjusting, and a round handle to set the start 
point of the first letter. 

70. Place the cursor over the baseline until it becomes four arrows.  Right click and 
select Properties from the pop-up menu.  Click at the end of ‘time’ in the first row of 
letters. 

71. Add a single space with the spacebar on your computer.  Click the DEL key on your 
keyboard to remove the second line of lettering.  Click OK to Letter Properties. 

72. You have added a space between the words ‘time’ and ‘saves’. 

73. Click and drag the control handle near the right end of the baseline until it sits about 
twelve grid squares lower than its original placement.  When you release the control 
handle, the letters will slant from upper left to lower right. 

74. Zoom  the view as needed to adjust the lettering. 
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75. At the left end of the baseline, where 
the lettering begins, an additional Step 
control handle on a short line allows 
you to change the angle of the 
lettering in relation to the baseline.  

76. Click and drag the Stepping handle 
about two grids down, then release to see how the angle changes in relation to the 
baseline. 

77. Click and drag the round circle for the letter start point along the baseline to see 
how the start point of the stitching moves with the circle. 

78. Move the circle back near the left (starting) end of the baseline. 

79. Adjust the control handle at the beginning or end of the baseline so the lettering will 
fit within the stitch area of the hoop, as the design can’t be saved if stitches sit 
outside the hoop area. 

80. Zoom to Fit  if needed to view the whole hoop. 

 
Fit to Wavy Line Can Follow Curves 

81. Click Fit to Wavy Line .  Click Apply in the Control Panel. 

82. Fit to Wavy Line works much like Fit to Straight Line, with 
the exception of how the baseline is shaped with the 
control points.  To make the baseline shorter, you may 
need to move the interior control points closer together, 
as they will cause a twist in the baseline if they are out of 
sequence on the line! 

83. Adjust the baseline as desired. 

 
Add a Motif and Snap the Lettering 

84. Click the Motif tab. 

85. In MiniDesign, click the drop-down and select Home 1.  Select design 2, the 
needle and thread.   

86. Click Options to the right of MiniDesigns and change Size to 25 mm.  Leave Height 
and Width at 100%.  Click OK to Options. 
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87. Click Apply in MiniDesigns to create the needle and thread. 

88. Click and drag the MiniDesign to move to an open area in the hoop. 

89. Click the Letters tab. 

90. All the lettering is still ‘open’ and can be changed at this point.  You can move 
between the Letter, Motif and Frame tabs without losing the options on each page. 
Once you select the Design tab or the Edit tab, all elements close and become 
embroidery elements, and you can only scale, resize, mirror, etc from that point. 

91. Press the Tab key on your keyboard to step through all the sets of letters, and you 
can see they are still open as Lettering. 

92. The Text Box still has two lines of lettering, as we opened the Properties from the 
pop-up menu in the Fit to Straight Line lettering. 
When creating letters in Full Circle, two lines of text cause the letters to break, 
wrapping the first line clockwise around the top of the circle, and the second line 
counter-clockwise around the bottom of the circle. 

93. Click Tab until the needle and thread are selected.   

94. In the Line Type, choose Full Circle .  Ensure the needle and thread design is 
surrounded by a select box.   

95. Change Size to 10.  Click the Options button, and change Width to 90%.   

96. Click the ellipsis  by Continuous Satin.  Change Density 
to 4.  Change Pattern to 0.  Place a check by Edge Walk in 
Underlay. 

97. Click OK to Continuous Column.   

98. Click OK to Options. 

99. Click Apply. 

100. The Lettering does not snap to the selected element! 

Lettering cannot SNAP to another element unless it has been closed and has become 
‘stitches’. 

101. Click Delete  to remove the last set of letters. 

102. Select the Design tab to ‘set’ or finish all the letters and the mini-design element. 

103. Select the Letter tab, and ensure the needle and thread is selected.  Use the 
keyboard Tab key if needed to select the needle and thread. 
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104. Click Apply, and the lettering will SNAP to the selected element. 

 
Don’t Forget the Help System 

105. The Help system contains extended information 
regarding the Letter tab.  While in the Letter tab, click the 
Help button in the Control Panel.  Help opens to 
information about lettering. 
You can also select the Index tab in the Help box, and 
type in specific references such as the word ‘Font’ for 
more links to help! 

106. Close  the Help box. 

 
Finalize the Design 

107. Click the Design tab in the Control Panel.  Press the Tab keyboard key to scroll 
through and fine-tune placement of the embroideries. 
Note that all letters and mini-designs are now closed to form stitch elements, and you 
can no longer right-click to open Properties or stitch change menus! 

108. Click Combine All . 

109. Click ColorSort  to reduce the number of color changes in the lettering. 

110. Click Center in Hoop  to center the combined design side-to-side and top-to-
bottom. 

 
Don’t Forget to Save your Embroidery! 

111. Click Save As .  Browse to your desired folder.  In File Name, type LettersLetters.  
Ensure Save As Type is .vp3 to save all special thread information and Notes. 

112. Click Save. 

113. QuickLink to 5D™ Organizer.  Browse to the folder containing your embroidery.  
Click once to select the design in the Thumbnail Preview.  Use Add Trim 
Commands , and save in the folder of your choice.  When trims have been 
added, touch F5 to refresh the view of the altered embroidery in 5D™ Organizer. 

 


